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CBSE | DEPARTMENT OF SKILL EDUCATION 
 

INFORMATION TECHNOLOGY (SUBJECT CODE: 802) 
Marking Scheme for Class XI (Session 2024-2025) 

 

 
Max. Time: 3 Hours         Max. Marks: 60 

 
General Instructions: 

1. Please read the instructions carefully. 

2. This Question Paper consists of 24 questions in two sections – Section A & Section B. 

3. Section A has Objective type questions whereas Section B contains Subjective type questions. 

4. Out of the given (6 + 18 =) 24 questions, a candidate has to answer (6 + 11 =) 17 questions in 

the allotted (maximum) time of 3 hours. 

5. All questions of a particular section must be attempted in the correct order. 

6. SECTION A - OBJECTIVE TYPE QUESTIONS (30 MARKS): 

i. This section has 06 questions. 

ii. There is no negative marking. 

iii. Do as per the instructions given. 

iv. Marks allotted are mentioned against each question/part. 

7. SECTION B – SUBJECTIVE TYPE QUESTIONS (30 MARKS): 

i. This section contains 18 questions. 

ii. A candidate has to do 11 questions. 

iii. Do as per the instructions given. 

iv. Marks allotted are mentioned against each question/part. 
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SECTION A: OBJECTIVE TYPE QUESTIONS 
 

 

Q1. Answer any 4 out of the given 6 questions on Employability Skills (1 x 4 = 4 
marks) 

i Receiving 1 

ii (a) No, irrespective of the climate, one should take a bath regularly. 1 

iii All of the above 1 

iv (b) Ctrl +n 1 

v True 1 

vi (d) All of the above 1 

Q2. Answer any 5 out of the given 7 questions (1 x 5 = 5 marks) 
i Hardware  1 

ii (a) ROM 1 
iii (b) Hard Disk 1 

iv (b)1,1 1 
v (c) All of the above 1 

vi Utilities  1 
vii (c ) Command 1 

Q3. Answer any 6 out of the given 7 questions (1 x 6 = 6 marks) 
i (a) Advanced Research Projects Agency NET 1 

ii (b) Malware 1 
iii Digital literacy  1 

iv (a) Star topology 1 
v Repeater 1 

vi  Eavesdropping 1 
i (a) Cyber bullying  1 

Q4. Answer any 5 out of the given 6 questions (1 x 5 = 5 marks) 
i (b) 1,3,4,2 1 

ii (d)All of the above 1 
iii (b)Complete a task 1 

iv (b)Predefined formulas 1 
v (b)Normal view 1 

vi True  1 
Q5. Answer any 5 out of the given 6 questions (1 x 5 = 5 marks) 

i (d)All of the above 1 
ii (c) Data cannot be shared  1 

iii False  1 
iv Unique 1 

v Describe 1 

vi True  1 

Q6. Answer any 5 out of the given 6 questions (1 x 5 = 5 marks) 
i Graphical user interface  1 

ii Parent or container controls  1 
iii Title bar 1 

iv False 1 
v (d)All of the above 1 

vi True   1 
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SECTION B: SUBJECTIVE TYPE QUESTIONS 
 

Answer any 3 out of the given 5 questions on Employability Skills (2 x 3 

= 6 marks) Answer each question in 20 – 30 words. 

Q. 7 Advantages of Verbal Communication  
It is easy and quick.  
You can say what you want and get a quick response.  
It is an easier form of communication when you have to exchange ideas.  
You keep changing your communication as per the other person’s reply.  
Disadvantages of Verbal Communication  
Since verbal communication depends on words, sometimes the meanings 
become confusing and difficult to understand if the right words are not used. 

½ X4=2 

Q. 8 Personal hygiene is important because it  
• helps us stay healthy.  
• creates a good image of ourselves.  
• helps us avoid feeling ashamed in public due to our bad breath, body odour, 
etc. 

• It helps prevent the spread of diseases and infections. 

½ X4=2 

Q. 9 Header is the top part of a page while the footer appears at the bottom of the 
page. They contain information that is available on every page at the same 
place, for example, if we want the title of the document at the top of each 
page and the page number at the bottom of each page, we can use a header 
(for title) or a footer (for page number) 

1X2=2 

Q. 10 Aspects to Keep in Mind While Understanding Customer Needs  
The above-mentioned needs about the specific product or service can be 
found out keeping in mind the following factors: 

 (a) Quality and Quantity: An entrepreneur must understand what a 
customer’s expectation in terms of the quality is.  

(b) Price: An entrepreneur must understand at what price the customer will be 
willing to buy a product of a particular quality.  

 (c) Location: Location means the place from where customers usually buy 
the product or service  

(d) Time: Time is also an important factor in understanding customer needs. 
An entrepreneur should understand in which season or at what time of 
the day, week or month, would a customer use the product or service.  

(e) Frequency: Frequency means the number of times a customer may buy 
the product or service.  

½ X4=2 

Q. 11 Role of the Government  
• The government makes policies and provides funds for implementing 

plans and policies.  
• It makes legislations (laws), such as ‘The Environment (Protection) Act, 

1986’ to protect the environment and take actions against law-breakers.  
• It sets up missions, such as the Green India Mission and National Solar 

Mission to act on green economy projects.  
• It works with scientists and educates the public on environmentally safe 

practices (pollution control, chemical-free farming). 

½ X4=2 
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Answer any 3 out of the given 5 questions in 20 – 30 words each (2 x 3 = 6 marks) 

Q12. • Hardware refers to the physical and visible components of the 

computer system, while software refers to the set of instructions that 

enable the hardware to perform tasks. 

• Hardware can be seen and touched, while software is in the form of 

code that cannot be directly perceived.  

1X2=2 

Q. 13 ·com - commercial business  
·edu - Educational institutions 
·au - Australia  
.nz - New Zealand  

½ X4=2 

Q. 14 • Step 1: Select the cell where you want to wrap the text. 

• Step 2: Press “Ctrl + 1” to open the Format Cells dialog box. 

• Step 3: Go to the “Alignment” tab of the Format Cells dialog box. 

• Step 4: Go to the “Text Control” section and select the Wrap Text 

checkbox. 

• Step 5: Click the “OK” button. 

½ X4=2 

Q. 15 1. Open the Microsoft PowerPoint program. 
2. Open the slide deck  
3. Select the slide where you want to insert the video. 
4. In the Ribbon menu bar at the top of the program window, click 

the Insert tab. 
5. On the Insert tab, click the Video option, then click the Video on 

My PC sub-option (shown below). 
6. In the Insert Video window, navigate to where the video file is 

located, select it, and click the Insert button. 

½ X4= 2 

Q. 16 The main differences between a list box and a combo box are3: 

• A combo box is a drop-down list that can be collapsed or expanded, 

while a list box is always visible and does not have a compact state. 

• A combo box allows the user to select a single value from the list, 

while a list box allows the user to select one or more values. 

• A combo box contains a text box field, so the user can type in a 

value that is not on the list, unless the DropDownStyle property is 

set to DropDownList. A list box does not have a text box field and 

limits the input to what is on the list. 

1X2=2 

 

Answer any 2 out of the given 3 questions in 30– 50 words each (3 x 2 = 6 marks) 

Q. 17 Slide Show Settings:  Slide Show -> Slide Show Settings. A dialog box 

opens. Select the slide to start from, animation allowed etc.  

Custom Animation: Slide Show -> Custom Animation. A dialog box 

opens on the right side of the screen. Select the element on the slide on 

which the animation has to be applied. Click <Add>. Select the animation 

to be applied.  

Slide Transition:  Slide Show -> Slide Transition. A dialog box opens on  

the right side. Select the transition you want to apply to the slide. 

1X3=3 

https://www.computerhope.com/jargon/r/ribbon.htm
https://www.computerhope.com/jargon/s/software-tab.htm
https://www.bing.com/ck/a?!&&p=f2f761665c7f18faJmltdHM9MTcxODU4MjQwMCZpZ3VpZD0yNTIxMWZkYy0zZDA3LTY2ZjQtMDc5Zi0wYjdkM2MzNzY3NTImaW5zaWQ9NTgyNg&ptn=3&ver=2&hsh=3&fclid=25211fdc-3d07-66f4-079f-0b7d3c376752&psq=Differentiate+between+ComboBox+and+ListBox&u=a1aHR0cHM6Ly9sZWFybi5taWNyb3NvZnQuY29tL2VuLXVzL3dpbmRvd3MvYXBwcy9kZXNpZ24vY29udHJvbHMvY29tYm8tYm94&ntb=1
https://www.bing.com/ck/a?!&&p=9f37c4e9925c7a48JmltdHM9MTcxODU4MjQwMCZpZ3VpZD0yNTIxMWZkYy0zZDA3LTY2ZjQtMDc5Zi0wYjdkM2MzNzY3NTImaW5zaWQ9NTgyOQ&ptn=3&ver=2&hsh=3&fclid=25211fdc-3d07-66f4-079f-0b7d3c376752&psq=Differentiate+between+ComboBox+and+ListBox&u=a1aHR0cHM6Ly9sZWFybi5taWNyb3NvZnQuY29tL2VuLXVzL2RvdG5ldC9kZXNrdG9wL3dpbmZvcm1zL2NvbnRyb2xzL3doZW4tdG8tdXNlLWEtd2luZG93cy1mb3Jtcy1jb21ib2JveC1pbnN0ZWFkLW9mLWEtbGlzdGJveD92aWV3PW5ldGZyYW1ld29ya2Rlc2t0b3AtNC44&ntb=1
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Q. 18 1. Easy to Use 

2. Secure 

3. Open Source 

4. Scalable 

5. Reliable 

1X3=3 

Q. 19 What is a button group? Which control is generally used with a button 

group. 

In Java, a Button Group is used to create a group of radio buttons. When 

buttons are added to the same Button Group, selecting one button 

automatically deselects the others in the group. Button Group can be 

used with objects that inherit from Abstract Button, such as JRadio 

Button, JRadio Button Menu Item etc. Radio button control is generally 

used with a button group. 

2+1=3 

 

Answer any 3 out of the given 5 questions in 50– 80 words each (4 x 3 = 12 marks) 

Q. 20 What is the purpose of the following views –  
a. Slide Sorter : This presents all slides of the presentation in a miniature 

form. It helps in viewing all slides together and allows easy moving of 
slides. 

b. Slide Show : It shows slides as they will be actually presented. No 
editing can take place in this view. 

c. Notes Page : Allows user to make notes for the selected slide. The 
notes can be seen only by the presenter while making a presentation. 

d. Handout Page : It displays slides on a page as seen when printed. 

1X4=4 

Q. 21 Protective Measures while accessing Internet  

● Never click on a suspicious link specified on a web page or send 

through a mail for which you are not sure about its authenticity.  

● Make sure that passwords are strong and are changed frequently. 

Passwords are the means for authenticating users, thereby allowing 

access to networked systems.  

● Never disclose personal information such as date of birth, home 

address, personal phone number, account details, passwords, credit 

and debit card details, work history details.  

● Report phishing issues to the concerned authorities or at 

cybercrime.gov.in. In case of unsolicited mails, mark them as spam 

mails.  

● Security of the communication made over the Internet can be indicated 

by the security of protocol being used.  

● Ensure that the web browser being used for accessing the web is 

updated and is secure.  

● Be selective while making friends on the social networking site. Do not 

send or accept friendship requests from any unknown user.  

1X4=4 

Q. 22 Primary Key: The group of one or more columns used to uniquely identify 

each row of a relation is called its Primary Key.  

Candidate Key: A column or a group of columns which can be used as 

the primary key of a relation is called a Candidate key because it is one 

of the candidates available to be the primary key of the relation. 

 Alternate Key: A candidate key of a table which is not selected as the 

primary key is called its Alternate Key.  

1X4=4 
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Foreign Key: A primary key of a base table when used in some other 

table is called as Foreign Key.  

Q. 23 (a) Select PrName from GYM; 
(b) Select PrName, UnitPrice from GYM; 
(c) Select PrName from GYM where Manufacturer= “fit Express”; 
(d) Select * from GYM order by UnitPrice desc; 

1X4=4 

Q. 24 Write the steps to Create a new Form   
To create a new application project called "Book":   

1. Choose File > New Project. Alternately, click the New Project icon in the 
toolbar.   

2. From the Categories pane select Java and in the Projects pane, choose 
Java Application. Click Next.   

3. Enter a name (in this case Book) in the Project Name field and specify 
the project location by clicking on the Browse button. By default, the 
project is saved in the NetBeans Projects folder in  My Documents and so 
this is the default Project location displayed in this field.   

4. Ensure that the Set as Main Project checkbox is selected and clear the 
Create Main Class field.   

5. Click Finish. 

1X4=4 

 


